Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER SEPARATE SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH, THESE SOFTWARE ITEMS ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH TIBCO, INCLUDING ANY TERMS CONCERNING SUPPORT, MAINTENANCE, WARRANTIES, AND INDEMNITIES. DOWNLOAD AND USE OF THESE ITEMS IS SOLELY AT YOUR OWN DISCRETION AND SUBJECT TO THE LICENSE TERMS APPLICABLE TO THEM. BY PROCEEDING TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU ACKNOWLEDGE THE FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, Statistica, Process Tree Viewer, Process Data Explorer, Predictive Claims Flow, Making the World More Productive, Live Score, Electronic Statistics Textbook, Decisioning Platform, Data Health Check, and Better Decisioning are either registered trademarks or trademarks of TIBCO Software Inc. and/or its subsidiaries in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

All other product and company names and marks mentioned in this document are the property of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms for a specific software version are released at the same time. Please see the readme.txt file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND “READ ME” FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to TIBCO’s Virtual Patent Marking document (https://www.tibco.com/patents) for details.
Contents

TIBCO Documentation and Support Services .................................................................................. 6
Installation Overview .................................................................................................................. 7
Named User Installation ............................................................................................................. 9
  Preinstallation Checklist for Named User Installation .......................................................... 10
  Installing Statistica Named User Installation .................................................................. 10
  Uninstalling Statistica Named User Installation ................................................................. 11
  Failed Registration ............................................................................................................... 11
CNET Installation ..................................................................................................................... 13
  CNET Server Installation ................................................................................................... 13
  CNET Workstation Installation .......................................................................................... 14
  CNET Server Uninstallation ................................................................................................ 15
  CNET Workstation Uninstallation ...................................................................................... 15
TIBCO Statistica Server ............................................................................................................. 16
  Preinstallation Checklist for Server Installation ............................................................... 17
  Installing Statistica Server Installation ............................................................................ 21
  Installing Statistica on the Workstation .......................................................................... 24
  Uninstalling Statistica Server Installation ....................................................................... 25
  Uninstalling Statistica Workstation Installation ............................................................... 25
  User Accounts ..................................................................................................................... 25
  Accessing the Web Server ................................................................................................. 26
  Using Additional Cores in Statistica Server ...................................................................... 26
  Notes on Failed Registration ............................................................................................. 28
TIBCO Statistica Monitoring and Alerting Server .................................................................... 29
  Preinstallation Checklist for MAS Server Installation ...................................................... 29
  Installing MAS Server Installation .................................................................................... 31
  Uninstalling MAS Server Installation .............................................................................. 32
  Notes on Failed Registration ............................................................................................. 32
TIBCO Statistica Live Score Server ........................................................................................... 34
  Preinstallation Checklist for Live Score Server Installation ................................................. 35
  Installing Live Score Server Installation ............................................................................ 36
  Uninstalling Live Score Server Installation ....................................................................... 36
  Using Additional Cores in Live Score ............................................................................... 37
Language Packs ....................................................................................................................... 40
  Installing Statistica Language Pack on Native Windows ..................................................... 40
  Uninstalling Statistica Language Pack on Native Windows ............................................... 41
  Installing Statistica Language Packs on English Windows ............................................... 42
Uninstalling Statistica Language Pack on English Windows .......................................................... 45
Possible Errors When Switching Languages .............................................................................. 47
**Upgrading TIBCO Statistica** ................................................. 50
  Upgrading Named User Installation .................................................................................. 50
  Upgrading CNET Server Installation .......................................................................... 51
  Upgrading CNET Client Installation ........................................................................... 53
  Upgrading Enterprise Server ....................................................................................... 54
How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other documentation included with the product. To access the latest documentation, visit https://docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO Statistica® is available on the TIBCO Statistica® Product Documentation page.

The following documents for this product can be found on the TIBCO Documentation site:

- TIBCO Statistica® Installation
- TIBCO Statistica® Quick Reference
- TIBCO Statistica® Release Notes
- TIBCO Statistica® Product Traceability
- TIBCO Statistica® Configuration for Windows Server 2012
- TIBCO Statistica® Data Entry Admin Guide
- TIBCO Statistica® Server Administrator’s Guide
- TIBCO Statistica® Options Configuration
- TIBCO Statistica® R Integration: Features and Options

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

- For an overview of TIBCO Support, visit http://www.tibco.com/services/support.
- For accessing the Support Knowledge Base and getting personalized content about products you are interested in, visit the TIBCO Support portal at https://support.tibco.com.
- For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You also need a user name and password to log in to https://support.tibco.com. If you do not have a user name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter experts to share and access their collective experience. TIBCO Community offers access to Q&A forums, product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and tools that extend and enable customers to gain full value from TIBCO products. In addition, users can submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to https://community.tibco.com.
Installation Overview

Before installing or upgrading to TIBCO Statistica® 13.5, ensure that your system meets the following minimum hardware and software requirements.

We recommend the 64-bit version of Statistica with 64-bit processor and operating system. If the 32-bit version of Statistica® must be used, we recommend running it in a 64-bit environment for better performance.

Important Instructions

- The 32-bit version of Statistica requires processor support for the SSE2 instruction set.
- The optional advanced hardware graphics support for transparency requires a graphics card that supports Direct2D.
- For integration with Python use 2.7.11 or 3.5.1. Panda 0.18.1 is also recommended for the extension functions. The comtypes module is required for Python integration.
- For R integration, R 3.2.1 is recommended.
- For H2O integration, H2O 3.10.4.7 and Sparkling Water 2.1.7 are recommended. This runs Spark 2.1.0.
- If you have purchased TIBCO Statistica® Pharma or TIBCO Statistica® Comprehensive, use the installation instructions for the following components:
  - TIBCO Statistica® Server
  - TIBCO Statistica Data Entry Server
  - TIBCO Statistica Monitoring & Alerting Server

Otherwise, if you have purchased without any add-ons, use the Named User Installation section.

If you have purchased an add-on, do not use the Named User Installation section. Use the installation that corresponds to the add-on that you have purchased.

Types of Installations

- **Single User or Named User Installation**: Also known as desktop user. It is without any add-ons. This installation does not include Statistica® Server, Statistica Live Score Server, Statistica Data Entry Server, Statistica Monitoring & Alerting Server, or CNET. To determine the type of install, look at the serial number provided to you in the fulfillment email. The serial number contains the version number, 135, near the end. For example, XXXXXXXXXXXXXX131-135. The serial number must not contain any one of the series of characters: CNET, ANCN, or WSEA. Do not use the name user installation if you have purchased an add-on.

- **CNET Installation**: This installation does not include Statistica Server, Statistica Live Score Server, Statistica Data Entry Server, or Statistica Monitoring & Alerting Server. This installation can be used by more than one user depending on the installation keys. To determine if you have this install, the serial number provided to you in the fulfillment email must contain CNET or CN near the end. For example, XXXXXXXXXXXXXCNETX-X. This installation includes a license manager. For more information on licensing, refer to https://support.tibco.com.

- **Server Installation**: This installation includes Statistica Server and might include one or more of the following add-ons: Statistica Live Score Server, Statistica Data Entry Server, and Statistica Monitoring & Alerting Server. To determine if you have this install, the serial number provided to you in the fulfillment email must contain WSEA near the end. For example, XXXXXXXXXXXXWSEAXXX-X. This is determined by what has been purchased.
This installation includes a license manager. For more information on licensing, refer to https://support.tibco.com.

All server add-ons require the use of the same server installation keys. One set of keys are used for all the add-ons.

Upgrade Considerations

Customers who have Statistica 12.0.65.4 or later installed on their computers can upgrade to version 13.5. They do not need installation keys and can just run the setup.exe. The installer prompts if the customer wants to upgrade the installation. The customers must select the check box agreeing to upgrade the older Statistica installation.

If you are using a version of Statistica earlier than 12.0.65.4, contact https://support.tibco.com to request Statistica 13.5 product key and serial number. Then uninstall Statistica and install Statistica 13.5.

Localization and Languages

There is a provision of language packs so that you can use the application in the required language. This requires separate installation and configuration.
Named User Installation

This licensing is also known as single user or desktop installation instructions.

Minimum hardware requirements for standard client configuration

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>32-bit version</strong></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>500 MHz</td>
</tr>
<tr>
<td></td>
<td>32-bit version of Statistica requires processor support for the SSE2 instruction set.</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>50 GB recommended per user</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 7 SP1 or later</td>
</tr>
<tr>
<td><strong>64-bit version</strong></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>2.0 GHz, 64-bit, quad core or more</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB RAM or more</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>50 GB recommended per user</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 10</td>
</tr>
</tbody>
</table>

Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Visual C++ 2012</td>
<td>Update 4 Redistributable Package (x64)</td>
</tr>
<tr>
<td>Microsoft Visual C++ 2017</td>
<td>Redistributable Package (x86)</td>
</tr>
</tbody>
</table>

If these requirements are not already installed, you can install these along with Statistica installation.

Authentication methods for Statistica Enterprise and Statistica Server

- Windows Authentication (Kerberos/NTLM)
- Microsoft Active Directory (LDAP)
- Custom (user database)
Preinstallation Checklist for Named User Installation

Follow the checklist before starting the Named User Installation.

- Users on their client machines must log on with Administrator permissions to complete the client installation. The installation makes necessary changes to the system. If you are prompted to reboot during the installation, you must log on with Administrator permissions after rebooting to complete the installation successfully.

- If you have any version prior to 13.5, uninstall Statistica. Refer to the Uninstalling section for uninstall instructions. Note that this method of removing Statistica does not affect or delete any data files created with previous installations. After this is complete, proceed with the installation instructions.

Installing Statistica Named User Installation

Procedure

1. You must decide which language you need to install. Visit https://edelivery.tibo.com and locate the product.

2. Download the installer and extract the contents of ZIP file to run the setup.

3. Ensure that no other applications are running.

4. Double-click setup.exe to begin the installation process. If you see a check box asking to upgrade the older Statistica installation, select the check box. For upgrading, refer Upgrading Named Used Installation.
   a) Click the Install Statistica button.
   b) The Welcome dialog box is displayed. Click the Next button.

5. In the Serial Number/Product Key dialog box, enter the Serial Number and 20-character Product Key in the respective boxes.

   - It is important to use the complete keyset as provided by Statistica.

6. To continue, click Next.

7. In the Install Code dialog box, enter the Install Code.

   - If you have selected the check box asking to upgrade or if you do not have an install code (part of the keyset), you do not see the Install Code dialog box.

8. To continue, click Next.

9. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click Next if you agree with the terms and want to continue the installation process.

10. In the Setup Type dialog box, select either Typical or Custom option button.

   - Typical setup installs Statistica with the most common options; this is the recommended selection.
   - Custom setup options are not covered in these instructions. If you have questions about the custom installation, contact Statistica for Technical support: https://support.tibco.com.

11. To continue, click Next.

12. In the Start Menu Folder dialog box, enter the Start Menu Folder Name. The default name is Statistica 13.
13. If you want to create a desktop shortcut to Statistica, select the check box. To continue, click Next.

14. In the Register with Statistica dialog box, enter the requested information in the appropriate boxes. This information is required to obtain the final licensing file for your software. To continue, click Next.

15. In the next dialog box, select a method of software registration. Note that all Statistica products must be registered to obtain the full license. An Internet connection is needed to automatically register, which is the recommended option.

16. To continue, click Next.

17. A message is displayed that prompts you to enable your wireless network adaptor. If your computer has a wireless network adaptor, enable it until installation is complete in order to ensure proper licensing of the software. After it is enabled, click OK.

18. Statistica attempts to register your software automatically. A dialog box stating that your license has been successfully registered is displayed. Click OK.

   - If the registration process fails, a different dialog box is displayed, indicating the failure. See the following failed registration section for additional details of failed registration.

19. Statistica is ready to install. To begin copying files to your machine, click the Install button.

20. You receive a message stating that the installation is complete. You are prompted to reboot now or reboot later, depending on the components that were installed on your machine. If you are prompted, you need to reboot before you run Statistica.

21. To complete the installation process, click the Finish button.

Uninstalling Statistica Named User Installation

To uninstall Statistica, follow these steps:

Procedure

1. Ensure that no other applications are running.

2. In the Control Panel, select Uninstall a program located under Programs.

3. Scroll down through the list of programs and select Statistica and click Uninstall.

4. A message is displayed to confirm that you want to uninstall Statistica from your computer. Click the Yes button, and Statistica files are uninstalled.

5. When the uninstall process is complete, click the Yes button to notify the registration server. This enables you to install Statistica on another computer.

Failed Registration

The software registration process can fail for several reasons including: exceeding the allowed number of installations for a serial number, lack of internet connection on the installed machine, incorrect serial number, or other technical difficulties.

- If you want Statistica installed on an additional computer, contact Statistica for information on our policy and additional pricing.

- If some other issue has affected your registration, ensure that the computer is connected to the Internet, and verify your serial number. Start Statistica.

   - If the Statistica Licensing dialog box is displayed, click the Register button. If the Statistica Licensing dialog box is not displayed, select the File tab. In the left panel, click Help/Support. In the right panel, under the Support heading, click Register.
If the registration process still cannot be completed, contact Statistica for technical support at https://support.tibco.com.
CNET Installation

CNET installation is also known as Concurrent User Installation.
This installation does not include Statistica Server, Statistica Live Score Server, Statistica Data Entry Server, or Statistica Monitoring & Alerting Server.
This installation supports Statistica 8.0 and later on, and Windows operating systems only.
The installation of the CNET version involves two parts on each of the client computers:
1. Server installation
2. Workstation installation

CNET Server Installation

Prerequisites

- Download the installer from TIBCO eDelivery and extract the contents on the computer where you want to install the CNET Server.
- Ensure that you have the following information that must be entered during installation:
  - Serial number
  - Product keys
  - Install codes (if applicable)
- All Statistica products must be registered to obtain the full license. To register the product automatically (which is the recommended method), ensure that you are connected to the Internet.

Procedure

1. Double-click the CDSTART.exe file from the extracted installation files to start the installer.
2. Follow the wizard-led instructions till you reach the Setup Type page.
3. On the Setup Type page, select an option based on your requirement.
   - **Typical**: Select this option to install Statistica with the standard options. This is the recommended selection.
   - **Custom**: You can select this option for a non-standard installation, for example, if you want to install Statistica on another drive or at a location other than the default C:\ProgramFiles \Statistica folder, or to change the program features that are typically installed.
     
     Instructions for custom installation are not included in TIBCO documentation. If you have questions about the custom installation, contact Statistica technical support.
4. On the Start Menu Folder page, enter the Start Menu folder name; the default name is Statistica 13. Select the check box Create a desktop shortcut to Statistica to create a shortcut. Click the Next button to continue.
5. In the Register with Statistica dialog box, enter the requested information in the appropriate boxes. This information is required to obtain the final licensing file for your software. Click the Next button to continue.
6. Statistica attempts to register your software automatically. A dialog box stating that your license has been successfully registered is displayed. Click the OK button. If the registration process fails, a different dialog box is displayed indicating the failure.
See the Notes on failed registration section for additional details of failed registration.

7. Statistica is ready to install. To begin copying files to your machine, click the Install button. This may take several minutes.

8. You should receive a message stating that the installation is complete. If a reboot is required, you might be prompted to reboot now or reboot later, depending on the components that are installed on your machine. If you are prompted, it is necessary to reboot before you run Statistica. Click the Finish button to complete the installation process.

What to do next

Share the Statistica executable directory. This shared folder needs to be available to all users who need to run the workstation installation. Users must have read and execute permissions to all files and subfolders:

To start using Statistica, double-click the Statistica shortcut on the desktop.

CNET Workstation Installation

If you want to access Statistica through a terminal server only, no workstation installation is necessary. If you want to install Statistica on the Workstation, follow these instructions.

Prerequisites

- Ensure that no other applications are running.
- OS requirement is Windows 7 or later.

Procedure

1. Locate the share that you created in CNET Server installation procedure when the Statistica program files were installed on the server.

2. Double-click the Setup.exe file in Workstation Installer 32 or Workstation Installer 64 subfolder depending on the bit-width of the workstation:
3. The Welcome dialog box is displayed. Click the Next button.
4. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click the Next button to continue the installation process.
5. In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name is Statistica 13. If you want to create a desktop shortcut to Statistica, select the check box. Click the Next button to continue.
6. Statistica is ready to install on your workstation. To begin copying files to your machine, click the Install button.
7. Your system is updated and program files are installed. In the Setup Wizard Completed dialog box, click the Finish button.
8. If you receive any Version Conflict messages, you can keep your existing file, click the Yes button.
9. If the workstation system files need to be updated, you must restart your computer to finish the installation process.
10. To start using Statistica, double-click the Statistica shortcut.

CNET Server Uninstallation

To uninstall the Statistica Server, follow these steps:

Prerequisites

Ensure that no other applications are running.

Procedure

1. In the Control Panel, Programs and Features, scroll down through the list of programs and select Statistica. Right-click and select Uninstall to uninstall the program.
2. A message is displayed to confirm that you want to uninstall Statistica from your computer. Click the Yes button, and Statistica files are uninstalled.
3. When the uninstall process is complete, click the Yes button to notify the registration server. This makes it possible for you to install the server on another computer.

CNET Workstation Uninstallation

To uninstall a Statistica workstation, follow these steps:

Prerequisites

Ensure that no other applications are running.

Procedure

1. In the Control Panel, select Uninstall a program located under Programs.
2. Scroll down through the list of programs and select Statistica.
3. Click Uninstall to uninstall the program.
TIBCO Statistica Server

The Statistica Server is an analytic engine service with a web-based user interface. You can consume analytic tasks interactively or schedule them for automated processing using the Statistica Server.

It is a good practice to install Statistica software be run on a server dedicated to the Statistica License Manager, and the Statistica Document Management Server (SDMS). The goal is to avoid sharing server resources with any other services.

This server can be referred to as the Statistica Application Server to avoid confusing it with the software product named Statistica Server.

If you want to enable versioning and approval for governance of analytics, you need to download two installers; TIBCO Statistica Software and TIBCO Statistica Documentation Management System (SDMS) Software.

If you don’t need governance and control over the analytic projects then you just need to download Statistica installer.

You can download the Statistica installer from the following products on https://edelivery.tibco.com:

- TIBCO Statistica Analyst
- TIBCO Statistica Comprehensive
- TIBCO Statistica Data Scientist
- TIBCO Statistica Enterprise
- TIBCO Statistica Expert - Data Science
- TIBCO Statistica Expert - Quality Control
- TIBCO Statistica Modeler
- TIBCO Statistica Pharma

You can download the Statistica installer from the following products on https://edelivery.tibco.com:

- TIBCO Statistica Analyst
- TIBCO Statistica Comprehensive
- TIBCO Statistica Data Scientist
- TIBCO Statistica Enterprise
- TIBCO Statistica Expert - Data Science
- TIBCO Statistica Expert - Quality Control
- TIBCO Statistica Modeler
- TIBCO Statistica Pharma

If the licensing includes Statistica Data Entry Server, then these instructions install this product on the same server with Statistica Server software. You also see this product use the name Statistica Web Data Entry Server.

Minimum hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz</td>
</tr>
</tbody>
</table>
## Requirement Details

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>4 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>50 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2012 or later</td>
</tr>
</tbody>
</table>

### Recommended hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>2.0 GHz, 64-bit, quad core or more</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>100 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2016</td>
</tr>
</tbody>
</table>

### Software requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Information Server (IIS)</td>
<td>Installed and configured to run ISAPI and CGI applications. Read TIBstat13.5configurationstatisticaserver.pdf</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>Install 3.5 and 4.6.1</td>
</tr>
</tbody>
</table>

System Requirements are based on an average size implementation.

**Preinstallation Checklist for Server Installation**

**Upgrading SDMS**

If you are working on a new installation, skip reading this section.

If upgrading SDMS 1.0.2.3 - 1.0.4.0, you need to complete a few extra steps. This must be completed before starting installation.

1. Request access code to add SDMS licensing on [https://support.tibco.com](https://support.tibco.com).
2. When you receive the access code, follow the emailed instructions on how to apply the code.
3. Copy ClientSTAT.tmp file from FlexLM server directory (example, C:\Program Files (x86)\Statistica\FLEXlm) to SDMS server directory. The file should be renamed to stat.lic.

The rest of the preinstallation checklist applies to new installations

**Read Admin Guides**

It is a good practice to read the admin guides posted on https://docs.tibco.com. Search for Statistica Document Management System and you can locate the SDMS Admin Guide and Server Admin Guide. Read the Server Admin Guide first.

**Database**

Statistica Server uses a database to store and manage metadata. An empty database must exist prior to starting the installer. The Statistica installer deploys a table schema as part of the installation process. It is a good practice to use SQL Server or Oracle database. If the limitations and performance of SQL Server Express is acceptable, this database can also be used.

If you decide to use SQL Server Express, create an empty database with login information. Retain this information and enter it during the installation.

If you want to use versioning and approval, make sure to select the SDMS component to install.

One new database needs to be created per environment (production, test, development). The following information assumes that SQL Server is used. This database is labeled Statistica Enterprise Schema, but it is typically named SEWSS.

Complete the following steps.

1. Create empty database that is used during installation for Statistica Enterprise Schema. It can be created on existing SQL Server database. This database should allow for at least 50 MB initial table space.
2. Create a SQL Server user account and make it the owner of Statistica Enterprise Schema. This user account needs permission to create new tables, views and indices.

After the installation, the permissions to create new tables, views and indices can be removed from this user account. This user account continues to need read/write permissions on the database for normal operations.

**Database Sizing and Location**

Statistica Server requires deployment of a metadata database schema on an ODBC compliant database. Most commonly, it is deployed on the existing customer DBMS infrastructure, such as Oracle or SQL Server. SQL Server Express can be used but must be installed manually. It supports other DBMS systems as well.

Customers who own Statistica Server also own licensing for the Statistica Document Management Server (SDMS) for managing version and approval history. Installing SDMS is optional, and it has a separate database schema, which is usually deployed to the same DBMS system where the metadata database has been deployed.

The database sizing requirements vary on usage. The actual metadata describing the Statistica objects is small, but the tablespace can be used to store reports and files (Excel, scripts) within the database (stored as BLOBs), which can increase the overall size.

The Statistica Server and the metadata database should be installed within the same local area network for performance reasons. The location of the data to be analyzed should also be reviewed when deciding where to install Statistica Server and the metadata database. Depending on the situation, customers might decide to install within their data center or at a local office to avoid transporting large amounts of data over a slow network.
**Recommended metadata schema database sizing**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial tablespace</td>
<td>1 GB, grow 1 GB intervals</td>
</tr>
<tr>
<td>If explicit cap required</td>
<td>100 GB but might need to grow over time</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft Windows Server 2012 or later</td>
</tr>
</tbody>
</table>

The Statistica Document Management Server schema contains only metadata about the individual document storage. The document storage is kept outside the database; therefore, SDMS tablespace requirements are minimal.

**Recommended SDMS schema database sizing**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial tablespace</td>
<td>100 MB</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft Windows Server 2012 or later</td>
</tr>
</tbody>
</table>

**Server (hardware or VM)**

   - A typical configuration is to have the operating system and Statistica installed on the C drive. Other programs (example, Microsoft Word) and TEMP space use the D drive. Contact [https://support.tibco.com](https://support.tibco.com) for help in sizing the D drive.
   - Edit the Windows TEMP and TMP environment variables so that the temp folder is located on the secondary (D:) drive.

   The Statistica workstation software can be installed on employee's desktop computers or laptops. Some customers prefer creating a Citrix or similar terminal services server that users log into for working with Statistica. This might be preferred because of data security or regulatory compliance.

**Optional: File Server**

Some customers have processes that require the use of a file server. Their data is in text or Excel files. For example, data sets might be published and shared between users on a file share. This file sharing can also be done using Enterprise Manager Application or a workstation server.

**Configuration for Statistica Server**

1. You must have a login account with administrative access.
2. Verify database client software is installed for SQL Server. This is the standard configuration for Microsoft’s operating systems.
3. Install client software for all DBMS system that data could be extracted from. In other words, if you need to analyze data from Oracle, Access or SAP, you need to install the ODBC or OLE DB drivers.
These client DBMS packages are needed both on the server as well as machines where the workstation client is installed. Recommend installing to secondary (D:) drive.

For 64-bit installations of Statistica the 64-bit versions of the database connectivity software should be installed.

4. Microsoft Internet Information Server (IIS) installed on server (IIS Management Console and IIS Management Service).


   - Internet Information Services > Web Management Tools > IIS 6 Management Compatibility > IIS Metadatabase and IIS 6 configuration compatibility
   - Internet Information Services > Web Management Tools > IIS 6 Management Compatibility > IIS Management Console
   - Internet Information Services > Web Management Tools > IIS Management Service
   - Internet Information Services > World Wide Web Services > Application Development Features > .NET Extensibility (For Newer version of Windows, .Net Extensibility 3.5 and .Net Extensibility 4.6)
   - Internet Information Services > World Wide Web Services > Application Development Features > ASP.NET (For Newer version of Windows, ASP.Net 3.5 and ASP.Net 4.6)
   - Internet Information Services > World Wide Web Services > Application Development Features > CGI
   - Internet Information Services > World Wide Web Services > Application Development Features > ISAPI Extensions
   - Internet Information Services > World Wide Web Services > Application Development Features > ISAPI Filters
   - Internet Information Services > World Wide Web Services > Security > Request Filtering
   - Internet Information Services > World Wide Web Services > Security > Windows Authentication

6. Microsoft Indexing Service installed to the server.

7. If required to save documents as Word documents or Excel documents, then installed Microsoft Office 2007 or greater. Installed to secondary (D:) drive.

8. Optional for preinstallation. This step can also be completed after installation. Create email account for Statistica application. The application sends email notifications.

Configuration Workstation Server or Workstation Client

1. If installing workstation on Citrix or VM, use a server login that has administrative access. If logging onto a desktop computer, a login with administrative rights is needed.

2. Verify database client software is installed for SQL Server. This is the standard configuration for Microsoft operating systems.

3. Install client software for all DBMS system that data could be extracted from. In other words, if you need to analyze data from Oracle, Access or SAP, you need to install the ADO.NET or ODBC drivers.

4. For 64-bit installations of Statistica, the 64-bit versions of the database connectivity software should be installed.
Installing Statistica Server Installation

Procedure

1. You must decide which language you need to install. Visit https://edelivery.tibco.com and locate the product.
2. Download the installer and extract the ZIP file to run the installer.
3. Ensure that no other applications are running.
4. Double-click setup.exe to begin the installation process. If you see a check box asking to upgrade the older Statistica installation, select the check box. For upgrading, refer Upgrading Enterprise Servers.
5. Click the Install Statistica button. The Welcome dialog box is displayed. Click the Next button.
6. In the Serial Number/Product Key dialog box, enter the Serial Number and 20-character Product Key in the respective boxes. If you have selected the check box asking to upgrade, you cannot see this dialog.
   
   It is important to use the complete keyset as provided by Statistica.
7. Click the Next button to continue.
8. In the Install Code dialog box, enter the Install Code. Click the Next button to continue.
   If you have selected the check box asking to upgrade, you cannot see this dialog and if you do not have an install code (part of the keyset), you do not see this dialog.
9. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click the Next button if you agree with the terms and want to continue the installation process.
10. In the Setup Type dialog box, if you have purchased TIBCO Statistica Live Score Server and/or TIBCO Statistica Monitoring & Alerting Server you must select the Custom option. Otherwise select Typical.
   
   ● Typical setup installs Statistica with the most common options. This is the recommended selection.
   ● Custom setup options are used to install Statistica on another drive or location or to change the program features that are typically installed.
11. If you have questions about the custom installation, contact Statistica technical support at https://support.tibco.com.
12. Click the Next button to continue.
13. In the Custom Setup dialog box you must deselect Live Score and Monitoring and Alerting Service. These products must be installed on a separate server. If you have selected Typical, you do not see this dialog.
14. To continue, click the Next button.

15. In the Enterprise Database Install Type dialog box, choose the type of installation: either create a new database, or use an existing database. Click the Next button to continue.

16. In the Statistica Server Reports dialog box, click the Next button to continue. This creates a shared drive to the web directory in which reports are placed. Default directory is C:\WebStatisticaPub\wwwroot\WebStatistica Enterprise\WSReports. It also configures your Statistica Enterprise database for Web report creation.

17. In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name is Statistica 13. If you want to create a desktop shortcut to Statistica, select the check box. Click the Next button to continue.

18. In the Register with Statistica dialog box, enter the requested information in the appropriate boxes. This information is required to obtain the final licensing file for your software. Click the Next button to continue.

19. In the next dialog box, select a method of software registration. Note that all Statistica products must be registered to obtain the full license. An Internet connection is needed to automatically register, which is the recommended option. Click the Next button to continue.

20. Statistica attempts to register your software automatically. A dialog box stating that your license has been successfully registered is displayed. Click the OK button. If the registration process fails, a different dialog box is displayed indicating the failure. See the notes under failed registration section for additional details of failed registration.

21. Statistica is ready to install. To begin copying files to your machine, click the Install button. This can take several minutes.

22. You can briefly see a DOS command window that states that the web service was started successfully.

23. You should receive a message stating that the installation is complete. If a reboot is required, you might be prompted to reboot now or reboot later, depending on the components that are installed.
on your machine. If you are prompted, it is necessary to reboot before you run Statistica. Click the Finish button to complete the installation process.

24. Create a share to the Statistica executable directory. This share needs to be available to all users who need to run the workstation installation. Users must have read and execute permissions to all files and subfolders.

25. To start using Statistica, double-click the Statistica shortcut, and type in the default login name - admin and password - abcdef. This launches the Statistica program.

26. Ensure that no other applications are running.

27. Download Statistica Documentation Management System (SDMS) installer and extract the ZIP file to run the setup.

28. Double-click Setup.exe to begin the server installation process.

29. The Welcome dialog box is displayed. If you are upgrading SDMS 1.0.6.0 or newer, select Yes you want upgrade. Click the Next button.

30. If you are upgrading SDMS 1.0.6.0 or newer, the Resuming the InstallShield Wizard for SDMS dialog box displays. Click the Next button. After the installation is complete, click the Finish button to complete. The installation process might require a reboot of the operating system before you can use SDMS.

31. If you are not upgrading using a new installation, the In the Setup Type dialog box is displayed. Select the installation type: Install both SDMS Server and Client. The SDMS client application is installed on the server to help with troubleshooting. This application should never be installed on a workstation.

32. The SDMS Product Key dialog box is displayed. You can enter the Serial Number and Product Key in the respective boxes.

It is important to use the complete keyset as provided by Statistica.

33. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click the Next button if you agree with the terms and want to continue the installation process.

34. In the Setup Type dialog box select the Typical option button to install standard program features.

35. In the Locate the Client Licensing file dialog:
   a) Click the Browse button and navigate to the directory containing the ClientSTAT.tmp file. This file is located on your Statistica licensing server, typically C:\Program Files
Installing Statistica on the Workstation

If a user is accessing Statistica Server only through a browser, no workstation installation is necessary. To install Statistica on the Workstation, follow these instructions.

Prerequisites

Ensure that no other applications are running.

Procedure

1. Locate the share that you created in Installing Statistica Server Installation, step 24, when the Statistica program files were installed on the server. Double-click the Setup.exe file in Workstation Installer 32 or Workstation Installer 64 subfolder depending on the bit-width of the workstation.

2. The Welcome dialog box is displayed. Click the Next button.

3. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click the Next button if you agree with the terms and want to continue the installation process.

4. In the Setup Type dialog box, select either the Typical option button or the Custom option button.
   - Typical setup installs Statistica with the most common options; this is the recommended selection.
   - Custom setup options are not covered in these instructions. If you have questions about the custom installation, contact Statistica technical support: https://support.tibco.com.

5. To continue, click the Next button.

6. In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name is Statistica 13. If you want to create a desktop shortcut to Statistica, select the check box. Click the Next button to continue.

7. Statistica is ready to install on your workstation. To begin copying files to your machine, click the Install button.
8. Your system is updated and program files are installed. In the Setup Wizard Completed dialog box, click the **Finish** button.

9. If the workstation’s system files need to be updated, you must restart your computer to finish the installation process.

10. To start using Statistica, double-click the Statistica shortcut, and type in the default login name - admin and password - abcdef. After installation, you must change this default administrator password.

11. If you receive any Version Conflict messages, it is recommended that you keep your existing file, click the **Yes** button. These are user preferences.

### Uninstalling Statistica Server Installation

To uninstall the Statistica Server, perform the following steps:

**Prerequisites**

Ensure that no other applications are running.

**Procedure**

1. In the Control Panel, Programs and Features, scroll down through the list of programs and select Statistica and SDMS. Right-click and select **Uninstall** to uninstall the program.

2. A message is displayed to confirm that you want to uninstall Statistica from your computer. To uninstall the Statistica files, click the **Yes** button.

3. When the uninstall process is complete, click the **Yes** button to notify the registration server. This makes it possible for you to install the server on another computer.

### Uninstalling Statistica Workstation Installation

To uninstall a Statistica workstation, perform the following steps:

**Prerequisites**

Ensure that no other applications are running.

**Procedure**

1. In the Control Panel, select **Uninstall a program** located under Programs.

2. Scroll down through the list of programs and select Statistica. To uninstall the program, click **Uninstall**.

### User Accounts

Statistica Server validates users based on groups defined on the Statistica Server computer. The following list states the groups:

- SWS_USER
- SWS_DOWNLOADFILES
- SWS_UPLOADDATA
- SWS_UPLOADSCRIPTS
- SWS_BATCHABLE
The minimum requirement for authentication on the web server is to be a member of the SWS_USER group.

The installation procedure for Statistica Server attempts to automatically create these groups for you. If this was not successful, you can create these groups on the Statistica Server using the Administrative Tools. You can achieve this by opening the Computer Management dialog box from the Control Panel - Administrative Tools menu. Navigate the tree to find Local Users and Groups listed. In the Groups folder, create the groups as listed.

Next, add Users to these Groups. Add all Statistica Server users to the SWS_USER group (Statistica Server administrators as well as Statistica Server users); then add the administrators to the SWS_ADMIN group, and so on. For customers using active directory, a best practice is to define global domain groups that correspond to the Statistica Server groups. Then add the global domain group to the corresponding local groups on the Statistica Server. For example, you can define a global domain group called GLOBAL_SWS_USER, and add this global domain group to the local SWS_USER created during Statistica Server install. Now you can control users to Statistica Server by using Active Directory tools to add or remove users from the GLOBAL_SWS_USER group.

Accessing the Web Server

Prerequisites

You must have the latest version of Java installed before you log on.

Procedure

1. Start your browser and type in the web address.
2. If you did not change the destination Web directory during installation, the address is http://your-server-name/WebStatistica. Chrome, Firefox, and Internet Explorer browsers are supported.

Using Additional Cores in Statistica Server

Statistica Server is able to distribute the processing of large jobs across multiple cores on the server. By default, an installation is configured to utilize two cores. You can purchase an additional license feature that permits more cores to be used, and then you must manually configure your Statistica Server installation to use those extra cores. This means you must increase the number of processes in the pool used to execute analyses on the server.

Statistica Server starts multiple processes that are standing by to handle tasks. There are two types of processes: short-term processes that handle UI activities and long-term processes that handle analyses.

Procedure

1. Select All Programs > Statistica > WebStatistica > Administration. In the Pooling section, select MaxLL.
2. The value for MaxLL, along with the value for MinLL, should be set to two times the number of cores available on the server. For example, a PC with one dual core processor has two cores.

3. The number of cores available depends on two things: how many physical cores are on the server and how many cores the Statistica Server license allows to be used.

4. The number of licensed cores can be determined by selecting All Programs > Statistica > Concurrent License Manager.
5. In the **Display By** group box, select the **Features** option button, and then locate the **WSNP** feature, which shows how many cores Statistica Server is licensed to use.

6. After you determine how many cores are available, multiply that number by 2, and set the **MaxLL** and **MinLL** values to that number.

7. **MaxSL** and **MinSL** can usually be left at the default value of 2. After making these changes, restart the WebStatistica service.

**Notes on Failed Registration**

The software registration process can fail for several reasons including exceeding the allowed number of installations for a serial number, lack of internet connection on the installed machine, incorrect serial number, or other technical difficulties.

1. If you want Statistica installed on an additional computer, contact Statistica for information on our policy and additional pricing.

2. If some other issue has affected your registration, ensure that the computer is connected to the Internet, and verify your serial number. Start Statistica. If the Statistica Licensing dialog box is displayed, click the **Register** button. If the Statistica Licensing dialog box is not displayed, select the **File** tab. In the left panel, click **Help/Support**. In the right panel, under the **Support** heading, click **Register**.

3. If the registration process still cannot be completed, contact Statistica technical support at https://support.tibco.com/.
TIBCO Statistica Monitoring and Alerting Server

This product is also known as MAS Server.

We recommend that Statistica MAS software be run on a server dedicated to Statistica MAS, independent from any other application software. Users can log onto a web browser to review the generated alerts. Alerts can also be configured to be sent by email.

Minimum hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>50 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2012 or later</td>
</tr>
</tbody>
</table>

Recommended hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>2.0 GHz, 64-bit, quad core or more</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>100 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2016</td>
</tr>
</tbody>
</table>

The Statistica Monitoring and Alerting Server (MAS) is part of the Statistica Server platform. Installation of the Statistica Server Application Server must occur prior to the installation of the MAS Server.

Preinstallation Checklist for MAS Server Installation

Configuration for MAS Server

1. Have a login account with administrative access with Windows 2008 R2 or later.
2. Verify database client software is installed for SQL Server. This is the standard configuration for Microsoft’s operating systems.
Step 2 is assuming SQL Server is being used for the metadata store. Oracle might have to be used for the metadata store of the Statistica Server installation instructions. For Oracle installations, the Oracle client must be installed with the TNSNAMES configuration set to connect to the Oracle database server. For installing to 64-bit Windows, refer to https://support.tibco.com/s/article/Installing-Oracle-client-for-Statistica.

3. These installation instructions assume that an installation of Statistica Server already exist on another server. If Statistica Server has not been installed, then we need to install it. The MAS Server depends on the existence of this software.

4. The location of the FlexLM license file on the Statistica Server must be shared and be accessible to the machine on which the MAS Server installation is performed.

Firewall Exceptions

The installation process creates firewall exceptions. The following program and ports are added to the firewall exception list by the installation process. Research if these ports are acceptable or other port numbers need to be used during the installation process.

- Name: Acresso Software Inc.
  Path: <flexlm install directory>\lmgrd.exe
- Name: Statistica License Manager daemon
  Path: <flexlm install directory>\sta_flxm.exe
- Name: Statistica License Manager Port: 26999
  Protocol: TCP
- Name: Statistica License Manager Port: 26998
  Protocol: TCP
Installing MAS Server Installation

**Prerequisites**

Ensure that no other applications are running.

**Procedure**

1. The installer used for Statistica Server installation is also used for the MAS Server installation. Double-click `setup.exe` to begin the installation process.
2. The installation process must begin automatically, and the Statistica installation dialog box is displayed. Click the **Install Statistica** button.
3. The **Welcome** dialog box is displayed. Click the **Next** button.
4. In the Serial Number / Product Key dialog box, enter the Serial Number and Product Key in the respective boxes. Click the **Next** button to continue.
5. If an Install Code was provided, you can see the Install Code dialog box. Enter the Install Code. Click the **Next** button to continue.
6. In the License Agreement dialog box, read the software license agreement. Select the **I accept the terms in the license agreement** option button, and click the **Next** button if you agree with the terms and want to continue the installation process.
7. Select a Custom install type. You might receive a message regarding WebStatistica. Ignore this message.


9. When prompted for the location of the ClientStat.tmp file, enter the shared directory location of the FlexLM license file on the Statistica Server.

10. In the Enterprise Database Install Type dialog box, choose the type of installation: use an existing database. This is the database that was created during the Statistica Server installation. Click the Next button to continue.

11. Enter the database credentials, including Allow Saving Password. Click Test Connection to verify the information.

12. Select Yes when prompted to install the Concurrent Session Manager.

13. In the Start Menu Folder dialog box, enter the Start Menu folder name; the default name is Statistica.

14. If you want to create a desktop shortcut to Statistica, select the check box. Click the Next button to continue.

15. Click the Install button to begin the installation.

16. Your system is updated and program files are installed. Click the Finish button in the Setup Wizard Completed dialog box.

Uninstalling MAS Server Installation

To uninstall the Statistica MAS Server, perform the following steps:

Prerequisites

Ensure that no other applications are running.

Procedure

1. From the Control Panel, select Programs and Features and scroll down through the list of programs and select Statistica. Click Uninstall.

2. A message is displayed to confirm that you want to uninstall Statistica from your computer. Click the Yes button, and Statistica files are uninstalled.

3. When the uninstall process is complete, click the Yes button to notify the Statistica registration server. This installs the server on another computer.

Notes on Failed Registration

The software registration process can fail for several reasons including exceeding the allowed number of installations for a serial number, lack of internet connection on the installed machine, incorrect serial number, or other technical difficulties.

1. If you want Statistica installed on an additional computer, contact Statistica for information on our policy and additional pricing.

2. If some other issue has affected your registration, ensure that the computer is connected to the Internet, and verify your serial number. Start Statistica. If the Statistica Licensing dialog box is displayed, click the Register button. If the Statistica Licensing dialog box is not displayed, select the File tab. In the left panel, click Help/Support. In the right panel, under the Support heading, click Register.
3. If the registration process still cannot be completed, contact Statistica technical support at https://support.tibco.com/.
TIBCO Statistica Live Score Server

This product is also known as Live Score.

The TIBCO Statistica Live Score Server is the analytic engine that receives and executes the Web Service (SOAP) scoring calls for Statistica Live Score. The analytic projects that the server executes are stored in the Statistica Server metadata database.

We recommend that Statistica Live Score software be run on a server dedicated to Statistica Live Score, independent from any other application software. This is a transaction server with an API. It does not have a user interface.

Minimum hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1 GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>50 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2012 or later</td>
</tr>
</tbody>
</table>

Recommended hardware requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>2.0 GHz, 64-bit, quad core or more</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB RAM</td>
</tr>
<tr>
<td>Hard disk space for installation</td>
<td>10 GB</td>
</tr>
<tr>
<td>Minimum Scratch/Temporary Disk Space</td>
<td>100 GB or more</td>
</tr>
<tr>
<td>Network Bandwidth</td>
<td>100 MBits/s or faster</td>
</tr>
<tr>
<td>Operating System</td>
<td>Microsoft Windows Server 2016</td>
</tr>
</tbody>
</table>

System Requirements are based on an average size implementation. Statistica Live Score applications often benefit from additional cores, depending on how many simultaneous requests are expected.

The Statistica Live Score is part of the Statistica Server platform. Installation of the Statistica Server Application Server must occur prior to the installation of the Live Score Server.
Preinstallation Checklist for Live Score Server Installation

Configuration for Live Score Server

- These installation instructions assume that an installation of Statistica Server already exists on another server. If Statistica Server has not been installed, then we need to install it. Live Score depends on the existence of this software.

  Live Score and Statistica Server (WebStatistica) components cannot be installed on the same server.

- The location of the FlexLM license file on the Statistica Server must be shared and be accessible to the machine on which the Live Score Server installation is performed.

- The server must be installed to a Windows 7 or Windows Server 2008 R2 operating system or later. Installations on Windows 7 are for training or sandbox environments.

- Have login account with administrative access for Live Score server.

- The computer on which you are installing Live Score is going to act as a web server. You must install the web server software on that computer before beginning the installation procedure.

Windows 7

From Control Panel > Programs > Programs and Features > Turn Windows features on or off, select the following features under Internet Information Services. From Web Management Tools, select IIS Management Console. From Common HTTP Features, select Static Content. From World Wide Web Services, Application Development Features, select ASP.NET, CGI, ISAPI Extensions. From Security, select Windows Authentication.


The Statistica installation process creates firewall exceptions. The following program and ports are added to the firewall exception list.

- Name: Acresso Software Inc.
  Path: <flexlm install directory>\lmgrd.exe

- Name: Statistica License Manager daemon
  Path: <flexlm install directory>\sta_flxm.exe

- Name: Statistica License Manager Port: 26999
  Protocol: TCP

- Name: Statistica License Manager Port: 26998
  Protocol: TCP

- Name: WebStatistica Service (also known as Statistica Server) Port: 8081
  Protocol: TCP
Installing Live Score Server Installation

Prerequisites

Ensure that no other applications are running.

Procedure

1. The installer used for Statistica Server installation is also used for the Statistica Live Score Server installation. This installer can be downloaded from https://support.tibco.com again.

2. Double-click setup.exe to begin the installation process. The installation process should begin automatically and the Statistica installation dialog box is displayed. Click the Install Statistica button.

3. The Welcome dialog box is displayed. Click the Next button.

4. In the Serial Number / Product Key dialog box, enter the Serial Number and Product Key in the respective boxes. It is important to use the complete keyset as provided by Statistica. Click the Next button to continue.

5. If an Install Code was provided, you can see the Install Code dialog box. Enter the Install Code. Click the Next button to continue.

6. In the License Agreement dialog box, read the software license agreement. Select the I accept the terms in the license agreement option button, and click the Next button if you agree with the terms and want to continue the installation process.

7. In the Setup Type dialog box, select the Custom option button. Typical setup installs Statistica with the most common options. However, for Live Score, de-select every option except the Statistica option and the Live Score option. If WebStatistica was purchased, the components for it are automatically included to install and Live Score is automatically deselected.

8. Click the drop down arrow next to the WebStatistica component and select This feature will not be available.

9. Then click the drop down arrow next to Live Score and select This feature, and all subfeatures, will be installed on local hard drive. If you have questions about the custom installation, contact Statistica technical support at https://support.tibco.com.

10. Click the Next button to continue.

11. In the Enterprise Database Install Type dialog box, choose the type of installation: use an existing database. This is the database that was created during the Statistica Server installation. Click the Next button to continue.

12. Enter the database credentials, including Allow Saving Password. Click Test Connection to verify the information.

13. Select Yes when prompted to install the Concurrent Session Manager.

14. Statistica is ready to install. To begin copying files to your machine, click the Install button. This might take several minutes.

15. You see a DOS command window briefly that states that the web service was started successfully.

16. You receive a message stating that the installation is complete. If a reboot is required, you might be prompted to reboot now or reboot later, depending on the components that are installed on your machine. If you are prompted, it is necessary to reboot before you run Statistica. Click the Finish button to complete the installation process.

Uninstalling Live Score Server Installation

To uninstall Statistica Live Score, perform the following steps:
**Prerequisites**

Ensure that no other applications are running.

**Procedure**

1. Open **Programs and Features** and scroll down through the list of programs and select Statistica. Right-click and select **Uninstall**.
2. A message is displayed to confirm that you want to uninstall Statistica from your computer. Click the **Yes** button to uninstall Statistica files.
3. When the uninstall process is complete, click the **Yes** button to notify the registration server. This makes it possible for you to install the server on another computer.

**Using Additional Cores in Live Score**

Live Score is able to distribute the processing of large jobs across multiple cores on the server. By default, an installation is configured to utilize two cores.

You can purchase an additional license feature that permits more cores to be used, and then you must manually configure your Live Score installation to use those extra cores. This means you must increase the number of processes in the pool used to execute analyses on the server.

Live Score starts multiple processes that are standing by to handle tasks. There are two types of processes: short-term processes that handle UI activities and long-term processes that handle analyses.

**Prerequisites**

**Procedure**

1. Select **All Programs > Statistica > WebStatistica > Administration**. In the **Pooling** section, select MaxLL.
2. The value for `MaxLL`, along with the value for `MinLL`, should be set to two times the number of cores available on the server. For example, a PC with one dual core processor has two cores.

3. The number of cores available depends on two things: how many physical cores are on the server and how many cores the Live Score license allows to be used.

4. The number of licensed cores can be determined by selecting `All Programs > Statistica > Concurrent License Manager`. 
5. In the Display By group box, select the Features option button, and then locate the LSNP feature, which shows how many cores Statistica Server is licensed to use.

6. When you determine how many cores are available, multiply that number by 2, and set the MaxLL and MinLL values to that number.

7. MaxSL and MinSL can usually be left at the default value of 2. After making these changes, restart the WebStatistica service.
Language Packs

You can install a language pack on the already-installed application. If the OS and language pack are in different languages, then refer installing language packs sections, Native and English Windows.

Installing Statistica Language Pack on Native Windows

Prerequisites

You must have Statistica 13.5 English with V135HFS04 must be already installed on Native Windows.

Procedure

1. Download the language pack .zip file from eDelivery. For example, download TIB_statlp_13.5.0_languagepack-ja.zip for Japanese language pack.
   The file names use two-letter ISO language code.
2. Move the language pack .zip file to the machine where Statistica 13.5 English with V135HFS04 is already installed.
3. Extract the language pack file. The following image displays the items in the .zip file:

   ![Image showing the items in the .zip file]

   a) For 64-bit machines, the typical path is C:\Program Files\Statistica\Statistica 13\  
   b) For 32-bit machines, the typical path is C:\Program Files (x86)\Statistica\Statistica 13\
5. Restart Statistica.

**Uninstalling Statistica Language Pack on Native Windows**

**Prerequisites**

Ensure that the Statistica application is not running.

**Procedure**

1. Delete the language folder from the Statistica application folder.
2. When you launch the application, it opens in English.

Installing Statistica Language Packs on English Windows

Prerequisites
You must have Statistica 13.5 English with V135HFS04 already installed on English windows.

Procedure
1. Download the language pack .zip file from eDelivery. For example, download TIB_stat-JA_13.5.0_win.zip for Japanese language pack.
   The file names use the two-letter ISO language code.
2. Move the language pack zip file to the machine where Statistica 13.5 English with V135HFS04 is already installed.
3. Unzip the language pack file. This file contains three items.
   a) For 64-bit machines, typical path is C:\Program Files\Statistica\Statistica 13\
   b) For 32-bit machines, typical path is C:\Program Files (x86)\Statistica\Statistica 13\
5. To change the computer settings, make sure the user has administrator permissions. There is a language macro file present in the downloaded folder.

6. After downloading the macro, change the region and language in Control Panel to the required language. You might also have to download and install MS language packs for the required language.
7. Go to **Control Panel > Language** and add the required language if it is not present.

8. Go to **Control Panel > Region** and change the region to the required language. For example, Japanese.

9. To change the system locale select the **Administrative** tab and click the **Change system locale** button.

10. Select the current system locale, for example, **Japanese** and click the **OK** button.

11. For the required changes to take effect, click the **Restart now** button.

12. After restarting, run the **Japanese.svb** macro by either opening the SVB macro in Statistica or double-click the svb file. This launches a Statistica instance, and displays the SVB file ready to run. Then click the arrow in the Debug section to run the macro.
13. If the macro runs successfully, no output is displayed. Close the application.

**Uninstalling Statistica Language Pack on English Windows**

Refer following steps for uninstalling Statistica Language Pack on English windows.

**Procedure**

1. Go to Control Panel > Region and change Regional setting back to English (United States).
2. On the **Administrative** tab, change the system locale to English.

3. To make the changes effective, you must restart Windows.

4. Delete the language folder from the Statistica application folder.
5. Run the English macro after restart. Double-click the English.svb macro, which opens the macro in the application.

6. Close the application. If the application stops working, choose close the program option.

7. Logout and login to Windows.

8. When you launch the application it opens in English.

**Possible Errors When Switching Languages**

Error might occur when switching languages. For example, English to Japanese.

**Possible Errors when switching to Japanese**

You cannot open macro when the application does not have All Files option. The following error is encountered.
Possible Errors when switching back to English

The login screen appears with some errors.
To resolve this error, make sure to remove the language pack folder from the Statistica application folder.

Application might stop working after running the English or Japanese macro. You must close the program in such case.
Upgrading TIBCO Statistica

If you have Statistica 12.0.65.4 or later installed, you can directly upgrade to version 13.5. Refer to the following topics for respective upgrades:

- Upgrading Named Used Installation
- Upgrading CNET Server Installation
- Upgrading CNET Client Installation
- Upgrading Enterprise Servers

If you have installed an earlier version of Statistica, contact TIBCO support to request for Statistica 13.5 keys. You must uninstall Statistica and install Statistica 13.5.

All Statistica updates must be uninstalled first before upgrading. All the updates are listed in the currently installed programs under Programs and features. No changes must be made to applied hotfixes.

Upgrading Named User Installation

The following procedure describes the steps to upgrade from version 13.3.1 to 13.5 for Named User Installation. The process is similar for any compatible upgradable version.

Prerequisites

OS requirement is Windows 7 or later.

Procedure

1. Download the installer files from the TIBCO eDelivery website.
   
   You can download the installer files using this link, How to download the Statistica 13.4 or 13.5 installer files. The full Statistica installer is used for upgrading.

2. To extract the files to a location of your choice, right-click the TIB_stat_13.5.0_win.zip file, and select Extract All.

3. Open the extracted folder and double-click CDSTART.exe. Follow the wizard-led instructions, and click Install button.

   When upgrading, you must select the check box on the welcome page of the wizard.
4. If prompted, restart your system.

**What to do next**

In-place upgrades do not update the license file. To update the license file, see What is a Statistica Access Code and how to request one.

### Upgrading CNET Server Installation

Refer the following steps for upgrading the CNET Server.

**Prerequisites**

OS requirement is Windows 7 or later.

**Procedure**

1. Download the installer files from the TIBCO eDelivery website.
   
   ![Statistica 13 64-bit Setup](image)
   
   You can download the installer files using this link, How to download the Statistica 13.4 or 13.5 installer files. Full Statistica installer is used for upgrading. Also, there is a separate installer for SDMS upgrades (TIB_STAT-DMS_13.4.0.WIN.ZIP).

2. To extract the files to the location of your choice, right-click the TIB_stat_13.5.0_win.zip file, select Extract All.

3. Open the extracted folder and double-click CDSTART.exe. Follow the wizard-led instructions, and click Install button.

   ![Welcome to the Statistica 13 64-bit Setup Wizard](image)

   When upgrading, you must select the check box on the welcome page of the wizard.
4. Click **Install** button.

5. You are prompted stating that the Statistica Server upgrade is complete.

Statistica Server here refers to the first part of the upgrade or the server part of the CNET install.

6. If prompted, restart your system.
What to do next

In-place upgrades do not update the license file. To update the license file, see What is a Statistica Access Code and how to request one.

Upgrading CNET Client Installation

Refer the following steps for upgrading CNET Client.

Prerequisites

OS requirement is Windows 7 or later.

Procedure

1. Share the Statistica 13 folder on the server with read and execute permissions.
2. Login to the workstation and run setup.exe from the Workstation Installer 64 (or 32) folder (a sub-folder of the Statistica 13 shared folder).
3. To upgrade the current install, select the check box. Follow the wizard-led instructions, and click Install button.
4. After the installation is complete, click Finish button.
5. If prompted, restart your system.
What to do next

In-place upgrades do not update the license file. To update the license file, see What is a Statistica Access Code and how to request one.

Upgrading Enterprise Server

The installer only upgrades the server component of a network install. After the server upgrade, workstations or clients are upgraded from the server. Refer the following steps for upgrading Enterprise servers.

Prerequisites

To avoid loss of information during upgrade, take a backup of the Network Analytics sub-folder (typical location is `<local server drive>:\Program Files\Statistica\Statistica <version #>`\). For Enterprise version (this includes Statistica Server, Live Score, MAS, Web Data Entry), take a backup of the Enterprise metadata database.

Procedure

1. Download the installer files from the TIBCO eDelivery website.

   You can download the installer files using this link, How to download the Statistica 13.4 or 13.5 installer files. Full Statistica installer is used for upgrading. Also, there is a separate installer for SDMS upgrades (`TIB_STAT-DMS_13.5.0.WIN.ZIP`). For upgrading SDMS, see `SDMS-13-4-1-0-10` and `SDMS-version-1-0-2-3-and-earlier`.

2. To extract the files to the location of your choice, right-click the `TIB_stat_13.5.0_win.zip` file, and select Extract All.

3. Open the extracted folder and double-click `CDSTART.exe`. Follow the wizard-led instructions, and click Install button.

   When upgrading, you must select the check box on the welcome page of the wizard.

4. Click Install button.
5. You are prompted stating that the Statistica Server upgrade is complete.

Statistica Server here refers to the first part of the upgrade or the server part of the CNET install.

6. If prompted, restart your system.

7. After the upgrade, when you start Statistica for the first time, the enterprise metadata database may require an update (when upgrading from 13.4 to 13.5, no upgrade is required). Click ok button.

8. To upgrade, click Yes button (if backup of database is already performed).

Click No button (if backup of database is not performed). Take a backup of the metadata database.
9. To start Statistica, click Close button.

What to do next

In-place upgrades do not update the license file. To update the license file, see What is a Statistica Access Code and how to request one.